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SZÉCHENYI ISTVÁN ALKALMAZOTT MECHANIKA 
 EGYETEM TANSZÉK 

 
 

Végeselem módszer 4. gyakorlat  

Síkbeli törtvonlaú tartó térbeli terheléssel 

 

 

 

Adott: 

A szerkezet geometriai méretei: 
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Anyag:  52 10 MPaE    

 0,3   

 

Kettő terhelési esetet definiálunk. Mindkét esetben az erő támadáspontja a C keresztmetszet. 

Első terhelési eset: 

 1 150 1000 Ny zF e e   

Második terhelési eset: 

 2 900 NyF e   
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Terhelési esetek: 1. koncentrált erő  

 2. koncentrált erő 

 

Végeselem modell/háló:  húzott-nyomott, hajlított-nyírt elsőrendű rúdelem.  

 Elemméret 5 mm.  

 

Szemléltetés:  

 A szerkezet deformáció utáni alakjának kirajzoltatása. 

 A csomóponti elmozdulások értékeinek kiíratása. 

 A legnagyobb elmozdulás helyének megkeresése és elmozdulás értékének kiíratása. 

 Az igénybevételi ábrák megrajzolása. 

 A veszélyes keresztmetszet megkeresése. 
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Indítsuk el az Abaqus CAE programot. Adjuk meg a munkakönyvtárat a File ► Set 

Work Directory… paranccsal. A megjelenő ablakban a New work directory alá 

írjuk/másoljuk be a munkakönyvtárunk helyét, vagy válasszuk ki a A select… ikonnal. 

Ezután OK-zuk le az ablakot. 

  
 

 

A program megnyitása után alapértelmezésként a Part Modulban vagyunk. Ez a Modul 

szolgál a geometria létrehozására. Ehhez az alábbi lépéseket kövessük: 

 

1. Az eszköztárból kattintsunk a Create Part ikonra. Az ennek hatására megjelenő Create 

Part ablakban az alábbi beállításokat végezzük el: 

 A Name után írjuk be az alkatrészünk nevét. 

 A Modeling Space alatt válasszuk ki, hogy síkbeli, azaz 3D geometriát 

szeretnénk rajzolni. 

 A Type alatt hagyjuk az alapértelmezett kijelölést a Deformable előtt, mivel 

alakváltozásra képes geometriát szeretnénk. 

 A Base Feature alatt válasszuk a Wire-t, mivel a rudakat vonalakkal fogjuk 

definiálni. 

 Az Approximate size-ot, tehát a modellünk méretét itt is beállíthatnánk, de erre 

majd később visszatérünk a segédrács beállításánál, most hagyjuk az 

alapértelmezett 200-on. 

A fenti beállítások elvégzése után kattintsunk lent a Continue… gombra. 

 
 

A1.1 A1.2 

A MODULE │ PART geometria megrajzolása 
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2. A Continue… gombra kattintás után azt tapasztaljuk, hogy a Part modul eszköztára 

megváltozott, a rajzolást segítő parancsok jelentek meg. Azt is megfigyelhetjük, hogy a 

program a rajzoláshoz az XY síkot ajánlja fel, és ebben a síkban automatikusan elhelyez 

egy rajzolást segítő kék segédrácsot (Grid-et). A geometria megrajzolása előtt – 

különösen egyszerűbb geometriánál – célszerű ezen segédrács méreteit a rajzolandó 

geometria méreteinek megfelelően beállítani, így egyszerűen meg tudjuk rajzolni a 

geometriát és megúszhatjuk annak beméretezését is. A segédrács beállításához 

kattintsunk az eszköztár Sketcher Options ikonjára. Az ekkor megjelenő Sketcher 

Options párbeszédablaknak a General fülének a Grid mezőjében végezzük el az alábbi 

beállításokat: 

 A munkaterület mérete legyen 300 mm, ehhez a Sheet size sorában az Auto elől 

vegyük ki a pipát, és írjunk be 300-et.  

 A rácstávolságot vegyük 10 mm-re. Ehhez a Grid spacing sorában vegyük ki a 

pipát az Auto elől és írjunk be 10-at. 

 A geometria megrajzolásához elég felhasználni a rácspontokat, további belső 

segédpontokra nincs szükségünk, ezért a Minor intervals-t állítsuk 1-re. 

A fenti beállítások elvégzése után kattintsunk lent az OK gombra. 

 

 
 

A2.1 A2.2 

 

3. A geometria megrajzolásához válasszuk az eszköztárból a Create Lines: Connected 

parancsot. Ezután a segédrács segítségével rajzoljuk meg a törtvonalú tartót 6 db vonallal.  

 Ha végeztünk a geometria megrajzolásával nyomjuk meg az Esc billentyűt. 

 Ha valaminek nem jó a méret, méretezzük be az Add Dimension paranccsal.  

Ahhoz, hogy a vázlatból vonalakból álló alkatrész legyen, a lenti beviteli mezőben 

kattintsunk a Sketch the section for the wire melletti Done gombra (vagy nyomjuk meg a 

középső egérgombot) Ennek hatására elkészül a Part-unk, és visszaáll a Part Modul alap 

eszköztára. 
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A3.2 

 

A3.4 

 

A3.1 A3.5 

 
 

B MODULE │ PROPERTY tulajdonságok megadása 
 

Válasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzőket, illetve rúd esetén 

a keresztmetszeti jellemzőket. Ehhez az alábbi 3 lépésen kell végmenni: 

 

1. Anyag definiálása: Első lépésként egy anyagot kell definiálnunk. Ehhez a Property modul 

eszköztárából kattintsunk a Create Material ikonra. A megjelenő Edit Material ablakban 

végezzük el a következő beállításokat: 

 Nevezzük el az anyagot: a Name: után írjuk be, hogy acél 

 A lineárisan rugalmas anyagjellemzők megadásához a Material Behaviors 

mezőben adjuk ki a Mechanical ► Elasticity ► Elastic parancsot 

 Az ekkor megjelenő Elastic mezőben az alábbi beállításokat végezzük el: 

o A Type mellett hagyjuk az alapértelmezett Isotropic-ot (az 

anyagtulajdonságok irányfüggetlenek) 

o A lenti Data táblázatban a Young’s Modulus alá írjuk be a rugalmassági 

tényezőt, azaz 2e5 (MPa) –t, a Poisson’s Ratio alá pedig a Poisson 

tényezőt, azaz 0.3-at.  
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B1.1 B1.2 B1.3 

 

2. Keresztmetszet profiljának definiálása: A Property Modul eszköztárából kattintsunk a 

Create Profile ikonra. Az ekkor megjelenő Create Prolife ablakban az alábbi beállításokat 

végezzük el: 

 Nevezzük el a keresztmetszetet: A Name: után írjuk be, hogy kor illetve teglalap. 

 A Shape alatt válasszuk ki a Circular –t illetve a Recatngular-t .  

Ezután kattintsunk a Continue… gombra. Az ekkor megjelenő Edit Profile ablakban 

adjuk meg a kör sugarát 5-öt illetve a tégalalap a=10, b=15 méreteket. Ezután 

kattintsunk az OK gombra. 

 

 
 

 

B2.1 B2.2 B2.3 
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B2.4 B2.5 B2.6 

 

3. Keresztmetszet definiálása: A Property Modul eszköztárából kattintsunk a Create 

Section ikonra. Az ekkor megjelenő Create Section ablakban az alábbi beállításokat 

végezzük el: 

 A Name-hez írjuk be a Section nevét kor illetve teglalap.  

 A Category alatt válasszuk ki a Beam –t (rúd) 

 A Type alatt válasszuk a Beam –t  

Ezután kattintsunk a Continue… gombra. Az ekkor megjelenő Edit Section ablakban 

a Material mellett megjelent az előző pontban definiált acél (többféle anyag esetén itt 

választhatnánk ki a kívánt anyagot), illetve a Profile name mellett pedig a korábban 

megadott szelvények. Itt válasszuk ki először a kor szelvényt majd következő lépésben 

a teglalap szelvényt. Ezután kattintsunk az OK gombra. 

 

  

 
B3.1 B3.2 B3.3 
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B3.4 B3.5 B3.6 

 

4. Keresztmetszet rudakhoz rendelése: A kersztmetszethez már hozzárendeltük az 

anyagot, így most már csak az előző pontban definiált keresztmetszeteket kell 

hozzárendelni a rudakhoz. Ehhez kattintsunk a Property modul eszköztárából az Assign 

Section ikonra. Ezután jelöljük ki a két függőleges rudat, majd a lenti beviteli mezőben 

kattintsunk a Done gombra. Ekkor megjelenik az Edit Section Assignement ablak, ahol 

válasszuk ki a teglalap section-t, majd OK. Ezután ugyan ezzel a paranccsal jelöljük ki a 

három vízszintes rudat és rendeljük hozzá a kor section-t. 

 

B4.2 

 
 

B4.1 B4.3 
 

B4.4 

 

B4.6 

 
 

B4.5 B4.7 
 

B4.8 
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5. Keresztmetszet orientációjának megadása: Végül adjuk meg a keresztmetszet 

profiljának orientációját az Assign Beam Orientation paranccsal.  Ezután jelöljük ki 

vízszintes rudakat, majd a lenti beviteli mezőben kattintsunk a Done gombra. Ekkor 

megjelenik az orientációt jelölő nyilak az ábrán látható módon, kattintsunk a középső 

gombbal. Majd még kétszer fogadjuk el a beviteli mezőben megjelenő adatokat a 

középső gombbal. Ezután újra kattintsunk a Assign Beam Orientation parancsra, majd 

jelöljük ki a két függőleges rudat. Ezután fogadjuk el a kijelölést és a lenti beviteli 

mezőben adjuk meg a keresztmetszet 1-es irányegység vektorának három koordinátáját 

(1,0,0) értékkel. Ezután kattintsuk kétszer a középső gombbal.  

A View ► Part Display Options… menüben a Render Beam Profiles opciót kapcsoljuk 

be így látjuk a tartóhoz rendelt I szelvényt.  

 

A5.2 

 

A5.3 

 

A5.4 

 

A5.1 A5.5 
 

 A5.6 
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C MODULE │ ASSEMBLY összeállítás 
 

Ennek a lépésnek több alkatrészből álló szerkezetek esetében van igazán jelentősége, mivel 

itt tudjuk létrehozni az összeállítást. Jelenleg csak egy alkatrészünk van, ennek ellenére nem 

hagyható ki a lépés, készítenünk kell egy egy alkatrészből álló összeállítást. Ehhez kattintsunk 

az Assembly modul Create Instance ikonjára, majd a megjelenő ablakot OK-zuk le. 

 
 

C1 C2 

 

D MODULE │ STEP lépések megadása 
 

A Step modulban a végrehajtandó vizsgálat(ok) típusát (pl. statikus, dinamikus, hőtani…), azok 

részleteit és sorrendjét tudjuk beállítani. Jelenleg 1 db statikus lépést kell definiálnunk. Ehhez 

kattintsunk a Step modul Create Step ikonjára. a megjelenő Create Step ablakban nevezzük 

el a lépést: a Name: után írjuk be, hogy terhelési esetek. A Procedure type-nál válasszuk a 

Linear perturbation-t. Ezután kattintsunk a Continue… gombra, majd a megjelenő Edit Setup 

ablakban hagyjunk mindent alapértelmezésen, csak OK-zuk le. 

 

  
 

D1 D2 D3 
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Következő lépésként kattunksunk a Field Output Manager ikonjára. a megjelenő Field Output 

Requests Manager ablakban kattintsunk az Edit gombra. Majd a felugró Edit Field Output 

Request ablakban a Forces/Reactions csoportból pipáljuk be az NFORCSO sort, majd OK. 

Ezzel a program az számítás során igénybevételeket is meghatározza.  

 

 

D4 D5 

 

 

 

D MODULE │ LOAD peremfeltételek megadása 
 

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogásokat) és 

dinamikai peremfeltételeket (terheléseket). Jelen feladatban 2 megfogást és 2 terhelést kell 

definiálni. 

 

1. megfogások definiálása: (az alábbi lépéseket kétszer kell végcsinálni) 

 Kattintsunk a Load modul Create Boundary Condition ikonjára. 

 A megjelenő Create Boundary Condition ablakban nevezzük el a megfogást fix-

nak, illetve csapagy-nak, a Category-t hagyjuk az alapértelmezett Mechanical-on, 

a Types for Selected Step alatt pedig válasszuk ki 

Symmetry/Antisymmetri/Encastre, illetve a Displacement/Rotation-t. Ezután 

kattintsunk a Continue… gombra.  

 Jelöljük ki a rajzon a fix, illetve csapágy helyét (kijelöléskor egy kis piros pont jelenik 

meg a kijelölés helyén). 

 A lenti beviteli mezőben kattintsunk a Done-re 
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 Az ekkor megjelenő Edit Boundary Condition ablakban fix megfogás esetén 

válasszuk az Encastre opciót, míg csapágy esetén az U2, U3, UR2, UR3 értékeket 

állítsuk 0-ra. OK-zuk le az ablakot. 

csukló megadása görgő megadása 

  
E1.1 E1.6 

  
E1.2 E1.7 

  

E1.3 E1.8 

  

E1.4 E1.9 

  
E1.5 E1.10 

 

2. terhelések definiálása: (a lenti lépéseket kétszer kell megcsinálni) 
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 Kattintsunk a Load modul Create Load ikonjára. 

 A megjelenő Create Load ablakban nevezzük el a terheléseket. A Category-t 

hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step alatt pedig 

válasszuk ki a Concentrated force-t koncentrált erő megadásnál. Ezután 

kattintsunk a Continue… gombra.  

 Jelöljük ki a rajzon a koncentrált erők helyét. (kijelöléskor egy kis piros pont illetve 

piros vonal jelenik meg a kijelölés helyén). 

 A lenti beviteli mezőben kattintsunk a Done-re 

 Az ekkor megjelenő Edit Load ablakban adjuk meg az erőkomponensek nagyságát 

N-ban: (F1 erő esetén CF2=150, CF3=-1000 és F2 koncentrált erő esetén CF2=-

900) 

 

Megoszló terhelés megadása Koncentrált erő megadása 

  

E2.1 E2.6 

  
E2.2 E2.7 

  

E2.3 E2.8 
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E2.4 E2.9 

  
E2.5 E2.10 

 

3. Terhelési esetek megadása:  

 Kattintsunk a Load modul Create Load Case ikonjára. 

 A megjelenő Create Load Case ablakban nevezzük el terhelési eseteket. Ezután 

kattintsunk a Continue… gombra.  

 Az Edit Load Case ablakban a Load fülön kattintsunk a zöld + ikonra (Add). Jelöljük 

ki a listából a terhelési esetnek megfelelő terhelést. Ezután OK gombra kattintsunk.  

 Az Edit Load Case ablakban lépjünk át a Boundary Conditions fülöre kattintsunk a 

zöld + ikonra (Add). Jelöljük ki a listából a terhelési esetnek megfelelő 

megfogásokat (együtt a fix és csapagy). Ezután OK gombra kattintsunk.  

 Majd kattintsunk az OK-ra 

 

1. terhelési eset 2. terhelési eset 

  
E3.1 E3.7 

  
E3.2 E3.8 
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E3.3 E3.9 

  

E3.4 E3.10 

  

E3.5 E3.11 

  
E3.6 E3.12 
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F MODULE │ MESH háló elkészítése 
 

A végeselem hálót a Mesh modulban tudjuk elkészíteni. Legelőször fent az Object-et állítsuk 

át Part-ra, aminek hatására a Part mellett megjelenik a rácsos tartó felirat. 

 
Ezután a hálózást az alábbi lépésekben végezzük el: 

 

1. Elemtípus megadása: 

 Kattintsunk a Mesh modul Assign Element Type ikonjára. 

 Jelöljük ki a teljes tartót, mivel minden rúdhoz ugyanolyan elemtípust szeretnénk 

rendelni. 

 A lenti beviteli mezőben kattintsunk a Done gombra 

 A megjelenő Element Type ablakban a Family-t állítsuk Beam-re, azaz húzott-

nyomott-hajlított-nyírt rúdelemre, illetve a Geometric Order-nél válasszuk a Linear 

opciót, majd OK-zuk le az ablakot. 

 

F1.2 

 

 

F1.1 F1.3 
 

F1.4 

 

2. Elemméret megadása: 

Ehhez az alábbi lépéseket végezzük el: 

 Kattintsunk a Mesh modul Seed Edges ikonjára. 

 Jelöljük ki az egész tartót. 

 A lenti beviteli mezőben kattintsunk a Done gombra. 

 A megjelenő Local Seeds ablakban a Basic fülön a Sizing Controls mezőben az 

Approximate element size-t 5-ra. Ezután OK-zuk le az ablakot. 
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F2.2 

 

 
F2.1 F2.3  F2.4 

 

3. Végeselem háló elkészítése: 

A végeselem háló elkészítéséhez kattintsunk a Mesh modul eszköztárában a Mesh Part 

ikonra, majd a lenti beviteli mezőben az OK to mesh the part? mellett a Yes gombra. 

 

 
 

F3.1 F3.2 

 

4. Hálótulajdonságok lekérdezése (opcionális) 

A csomópontok és végeselemek számának ellenőrzéséhez a Tools ► Query… 

Parancsot használhatjuk. A felugró Query ablakban a General Queries mezőben 

kattintsunk a Mesh-re, majd a lenti beviteli mezőt a Query entire part-on hagyva a Done 

gombra. Ekkor a lenti párbeszédablakban megjelenik a csomópont szám (Total number 

of nodes) és az elemszám (Total number of elements). Jelen feladat 14 csomópontot és 

25 végeselemet tartalmaz. 

 
 

 

E4.3 

 

E4.1 E4.2 E4.4 

 

G MODULE │ JOB feladat megoldása 
 

A feladatot a Job modulba átlépve tudjuk lefuttatni. Az ehhez szükséges lépések: 

 

1. Feladat definiálása: 

 A Job modul eszköztárából kattintsunk a Create Job ikonra 

 A megjelenő Create Job ablakban kattintsunk a Continue… gombra 
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 A megjelenő Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le 

 

 

 
G1.1 G1.2 G1.3 

 

2. Feladat lefuttatása: 

 A Job modul eszköztárából kattintsunk a Job Manager ikonra 

 A megjelenő Job manager ablakban alapból ki van választva az előbb definiált 1 

db feladat (Job-1). Kattintsunk a Submit gombra. 

 Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen lefutott. 

Az eredmények megjelenítéséhez kattintsunk a Results gombra. 

   
G2.1 G2.2 G2.3 

 

 

H MODULE │ VISUALIZATION eredmények megjelenítése 
 

A Results gombra kattintva automatikusan a Visualisation modulba kerülünk. Fent válasszuk 

ki az U-t vagy az S-t annak megfelelően, hogy az elmozdulást, vagy a feszültséget szeretnénk 

megjeleníteni. Először válasszuk az U-t. 

 
A Plot Contours on Deformed Shape ikonra kattintva a deformált alakot láthatjuk. 
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Bal felül látható színskála alapján a maximális elmozdulás 1,585 mm és 0,275 mm, a két 

terhelési esetben. 

 

Az Odb Display Options-ban megjeleníthetjük a keresztmetszetet tetszőleges mértékben 

felnagyítva.  
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A Common Plot Options-ban a Basic fülön beállíthatjuk a deformáció felnagyításának 

mértékét, a Labels fülön bekapcsolhatjuk a csomópontok és elemek sorszámának 

megjelenítését. 

 
 

 

A Contour Options-ban a Limits fülön bekapcsolhatjuk a max/min helyek megjelenítését. 

 
 

Fent a feszültséget választva a Contour Plot Options Basic-re kattintva az alábbi ábrát 

kapjuk, a koncentrált terhelési esetben.  
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A három terhelési esetre kapott eredmények között a grafikus ablak jobb felső sarkában lévő 

nyilakkal tudunk váltani.  

 
 

Az adatok táblázatszerű lekéréséhez használjuk a Report ►Field Output… parancsot. 

 A Position-t Unique Nodal-ra állítva jelöljük ki az U (elmozdulás) alatti négyzeteket. 

Ezzel az elmozdulások nagyságát, illetve x és y összetevőit tudjuk lekérni 

csomópontonként. 

 Kattintsunk az Apply gombra 

 Szedjük ki az összes pipát 

 A Position mellett válasszuk a Centroid-ot 

 Az S (feszültség) alatt válasszuk a Mises-t. Ezzel a HMH szerinti redukált 

feszültséget tudjuk lekérni elemenként. 

 Kattintsunk ismét az Apply gombra. 
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A munkakönyvtárban a fentiek hatására egy abaqus.rpt nevű fájl keletkezett, mely a lekért 

adatokat tartalmazza. 

 

 

 

 

 


